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UTTAR PRADESH POWER CORPORATION

[Participant 1D
Participant Name

Test Center Name

Test Date 21/11/2022

Test Time 9:00 AM - 12:00 PM
Subject |[Executive Assistant

LTD.

Q.1 TAIES 2 (Slide Show) AL BT FFHfIAT & | Fi9-1 fIwey W FHie TWIss, AR TWIgS
3R TR ey Fi feamar 8, FPrad g0 Tiuy-ulavulge 365 W U9 & TUG BleH
F 3R =Bl & A1y Jo= A Hergar firadt 82

Ans X' A T Hif$TI HCied (Show Media Controls)
o B. ol USieR & (Use Presenter View)
X C. W TR (Play Narrations)

X D. goT <R (Use Timings)

Question ID : 396136915
Status : Answered
Chosen Option : A

Q.2 gfE TH MS-Excel 365 H TS & A #, Afthd Top 75 o151 U 2T YA ST 91gd @, Y
fFrafafaa o @ f$a #161S qTéde (keyboard shortcuts) BT ITART fHaT STEM?

Ans X A.Ctrl + Esc
25 B.Alt+Esc
X C. Shift + Enter
" D. Alt + Enter

Question ID : 396136926
Status : Answered
Chosen Option : B
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Q.3 Te pyer Fafiafad &  fa W (language) & W TUH TP 872
Ans g A [RISESN (Low-level)

25 B. HHH IR (Medium level)

X C.I=a-%R (High-level)

5 D. 9 TR (Object level)

Question ID : 396136954
Status : Answered
Chosen Option : C

Q.4 BM-360 W, Foger ) fFafafea d & fra fidt @ Tdfta 32
Ans A UYH

X B.agd

X c.fgda

« D. T

Question ID : 396136951
Status : Answered
Chosen Option : D

Q5 fmfifeaa & @ H19-a1 o, el 1 ue fAyerdt Aead 8, B Aeas! &1 Acad off
FHET AT 82

Ans X' A G (VLAN)
X B. T (MAN)
« C. HCd (Internet)
X D. acs a1 39 (World Wide Web)

Question ID : 396136939
Status : Answered
Chosen Option : C

Q.6 fEfafad d A -, s 9 T fadvar T8 22
Ans X' A TI(d (Speed)

« B. {3 T (Intelligent quotient)

5 C. Y&dl (Accuracy)

X D. Ig3HTATH UferyT (Versatility)

Question ID : 396136950
Status : Answered
Chosen Option : B
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Q.7 frgferfad # A S19-91 9, $-Ad (e-mail) F TeH A WH (spam) T I w31 &1
e T 82
Ans X A T (spam) Gl T ofard 7 1
< B. W ey ¢ (spam filtering tools) 3R TE-araRY At dR (anti-virus software) Eal
SIIAAIS BT
o C. 3T 30 (e-mail) Td B! Ardui-es FU F G AT A1 URE H=AT

X D. et ot RIS (hyperlink) TR fad® &3 ¥ Ugd T

Question ID : 396136908
Status : Answered
Chosen Option : A

Q.8 MS-Excel 365 ¥ 3rspie vH H faid! & Gt &1 @Ra w0 A 91 F forg FHufarfaa o
B fr faweu &1 IualT far &1 gwdr 22

Ans X' A 3iicI §TSS (Auto hide)
« B. fi5d €84 (Fill Handle)
X C. 3ffcl AT (Auto Complete)
< D. 31l H (Auto Run)

Question ID : 396136924
Status : Answered
Chosen Option : D

Q9 TCPU® MIPId 8, SaiP UDP TP MarPpia gl
Ans o A W—W@I (connection-oriented); FHRRA- (connection-less)

X B. TQI$HIE-AR (application-layer); HaRM-3RUCS (connection-oriented)
X C. FHFRH- (connection-less), FaRH-3NRICs (connection-oriented)
X D. HARA-AT (connection-less); IR IH-TR (application-layer)

Question ID : 396136943
Status : Answered
Chosen Option : B

Q.10 IyaRTFHars & dta W= & SeH-UgH & fore Fufafed # & o9-w1 suger snutfa
TS TEHRHE 82
Ans X A S-bargdl (e-kyc)
«” B. -0 (e-mail)
X C.3-3MYUR (e-aadhar)
X D. 3-9M (e-sharm)

Question ID : 396136907
Status : Answered
Chosen Option : B
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Q.1 fAgfafEa 3 | $19-41 filex, e §o-Raq IR U7 aR®R 31eRT &) oruar 82
Ans g A 3ic ﬁﬁ}ﬂ? (Dot matrix)

X B.Uds3l (LED)

X C. TSR (Laser)

X D. ¥Fue (Inkjet)

Question ID : 396136952
Status : Answered
Chosen Option : D

Q.12 guI 3memiya STaRTET RIFeH (Operating Systems) & TeH ¥ fFafafea & & Hl-w”A
FYT TG 3R

(i) 319 (DOS) 3R =19 (Linux) 91 GUI 3T g1 &1
(ii) ST (DOS) 3R A (Unix) SIFT GUI et gia &1

Ans o A FT() T (i)
X B. Had (i)
X C. %Had (i)
X D. (i) 3R (ii) gFf

Question ID : 396136944
Status : Answered
Chosen Option: D

Q.13 T3P 2016 A $-AA (e-mail) T T FHISH (smiley emoji) STa & forg FraferfeEa &
¥ fra udter 1 IuaT foraT SiTar 82

Ans X A :-O
< B.)
« C. o)
X D.

Question ID : 396136909
Status : Answered
Chosen Option : C

Q.14 Fgfifad ¥ § $H-91, T JI8wR A T8 872
Ans A SHSHII (DuckDuckGo)

X B. DI (Chromium)

X C. UISHhNTH T (Microsoft Edge)

X D.sid (Brave)

Question ID : 396136919
Status : Answered
Chosen Option : A
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Q.15 MS-Excel 365 # Uf$T HIS (Edit mode) H ®Td URY H & feorg, fFafafad o & #i9-an
T el e 82
Ans X A 39 I R fade o1 o/ a8 ST 2 R oa Jurfed &em ared €, SR R F2 Y
g
X B. 39 0 R G H1 foraw 98 ST o 3y Turfed &= a1gd €, 3R bR widen
TR T wal i fFae w=n
X C. 39 Y R SIT-[Fae BT S 98 ST 8 o 3y Jutfed &1 agd &
o D. 3T U0 R e o1 forad ag a1 8 ot oima Yurfed oven aed €, 3R R Fs
AT

Question ID : 396136927
Status : Answered
Chosen Option : D

Q.16 THEH-UTGRUISC 365 H fhefl BIEa &) A9 31 $1 98! ey Fafef@a & d S-ar g2
Ans X A fSSET (Design) -> 94 (Save)

« B. BI3d (File) -> ¥d (Save)

X C. ST (Draw) -> ¥d (Save)

X D. 3¢ (Insert) -> ¥ (Save)

Question ID : 396136912
Status : Answered
Chosen Option : B

Q.17 TaHY |S (access speed) F Tgd H & "o # fAufafaa o § F19-u1 faweu wgt 82
Ans o A
Heafesr a9 (Magnetic tape) > iifteswer R (Optical disk) > =1 A#{ (Cache memory) > IorEed (Registers)

< B.

#Afrs 2T (Magnetic tape) > 3ifSzeer BT (Optical disk) > For AT (Cache memory) > A AAE (Main memory)

X C.
sHifewer Rk (Optical disk) > #eafes T (Magnetic tape) = =1 FHITr (Cache memory) > ITFSTEd (Registers)

2 D.
#Hiftzerer f#es (Optical disk) > Heafes &9 (Magnetic tape) > Main memory > 321 Al (Cache memory)

Question ID : 396136956
Status : Answered
Chosen Option : C

Q.18 MS-Excel 365 ¥ fhft 3= faia TR Rivew W Iuaiv farg oA & forg, fnslt adbgas
P HIAI-FSFARIRS (comma-delimited) THRE BT3d & ¥4 A T (save) F31 A Fufafaa
U A fory wIge Bive ST IUANT fohar Srar 32

Ans X A TRC (THUY-8N) Text (MS-DOS)
o B. FTHd! (@1 fSfiffies) csv (comma delimited)
X C. gF®I8 CRE (Unicode Text)
X D. BIHE TRE (Formatted Text)

Question ID : 396136925
Status : Answered
Chosen Option : C
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Q.19 fmferfad # @ ®19-a1 faeey FufifRad su=) @) gaar 1 ¥aid 9o $3a1 872

(i) f[iSIe TP aR (Windows taskbar) TTHIRI U A TPIF & faa UIT W= U &fas Yar
& w0 A faarg qar 31

(ii) fISIST 10 TPAR (Windows 10 taskbar) & T T S16T 81T & fI®T IO Hgex
3R A9 ST B FTSW B P forg fvar o7 Wepe1 @

Ans X A. (i) - I, (i) - 3T

X B. (i) - 39, (i) — T
X C. (i) - 319, (i) — 3™
& D. (i) - 9, (i) — I

Question ID : 396136948
Status : Answered
Chosen Option : B

Q.20 MS-Word 365 & fAaferfad ¥ & fa faweu &1 IuaT AdTRS TR (selected text),
TRTIT® (paragraph) TT 39d T (table cell) & T BT T 9ga & e frar S 82

Ans g A ST (Shading)
X B. 3R BIEAISE HeR (Text Highlight Color)
X C. i< HeR (Font Color)
X D. TR ghacy TS TRUMTH! (Text Effects and Typography)

Question ID : 396136937
Status : Answered
Chosen Option : D

Q.21 THUY-UTGRUTEC 365 H, Ve 37 TS T (Set Up Slide Show) & fAaferfad d & fea
famey o1 IuahT, WIS W $Y 99 9P qU B & o e S &, 519 99 o 59 q@
T AT Esc Poit(key) T SaTE?

Ans A TS TUCT forae (Pd %cb“H) (Browsed.at a kiosk (full screen)
& B. mﬁ@%’%ﬁﬁﬁ (Bd Fﬁﬂ) (Presented by an individual (full screen)
X C. T3S 913 A fsfagerd (fdS) (Browsed by an individual (window)
X D. ﬁﬁ%@?ﬂ]’éq Eavirond (pd Hﬂ?) (Presented by a speaker (full screen)

Question ID : 396136918
Status : Answered
Chosen Option : C

Q.22 fAgfifad & § H9-8 399, MS-Word 365 ¥ AR s Toe ¥ Wit BT #l gem &
fore SuahT fbT WM aTe SMg = FI gwifet 32

XA £

X8

vC b

Ans

xXb A

Question ID : 396136933
Status : Answered
Chosen Option : C
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Q.23 HugeR @t goI ARl i@ ¥ @ 59 ae-e &1 SuaT HXb §1s wTdl 82
X A. B9fe® (Magnetic)

X B. 3ifPehel (Optical)

o C. YH-&HSaeR (Semi-conductor)

X D. 39gH &4 (Vacuum tube)

Ans

Status : Answered
Chosen Option : C

Question ID : 396136953

Q.24 THUY-UTGRUTSE 365 H SHAT (Template) BT ITANT HIP Yol ¢RI A1 BT A1 bl
Frafafe & 9 s=-a1 82

& A BTsd (File) -> 3o (Open) -> Td BR &ﬁ%ﬂﬁqm us A= (Search for online
templates and themes)

X B. ®Isd (File) -> e (Recent) -> Td BR AT é’qaﬁ g i (Search for online

templates and themes)

X C.WISd (File) -> 8 (Home) -> Td BIR a8 Uy TS AT (Search for online
templates and themes)

« D. BT (File) -> g (New) -> Td HBR A Uiy U8 I (Search for online

templates and themes)

Ans

Question ID : 396136913
Status : Answered
Chosen Option : C

Q.25 frgfafad & A 19 91 fdwe JPra HI TSR (Google Chromebrowser) H T TYUT A
U 1 fife B &1 T FH 82

o A. 39 TS Gt -> Ctrl + A TETY -> O TR Y13 e &R 3R fife’ )R dve faas s

(Open the web page -> Press Ctrl + A -> Right click on the page and left click on ‘Print’)

X B. 39 U Widt -> U YT 3™ W fadd &% -> fiie aMEdhd RiGas &
(Open the web page -> Click on Page Setup -> Click on the ‘Print’ icon)

X C. 39 U Wil -> Cirl + S &MY -> Ul WR FE et o3 3R flle’ )R Ave faas &
(Open the web page -> Press Ctrl + S -> Right click on the page and left click on ‘Print’)

X D. 39 U9 Wit -> fiie tieg W faaes & -> fiie’ smga wRidas o

(Open the web page -> Click on Print Preview -> Click on the ‘Print” icon)

Ans

Question ID : 396136922
Status : Answered
Chosen Option : B

Q.26 fEft fFeSIe 10 STORFET RTeH (Windows 10 operating system) # 3¥He1U IHUTSS
(Desktop background) @ Sea- & fore fRaffaa o & foraeT Suwi frar o goar 82

X A SHHCId R Tl Hf 39 fadad H

 B. SWHe R 3C faads HY 3R TS (Personalize) =M &1 Jaide &Y
X C. Sl R dal Hi feud fakie a

X D. 3WHeld R 5T fG0d HY 3R ' (New) TR B Jade B

Ans

Question ID : 396136947
Status : Answered
Chosen Option : D
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Q.27 geve W AREh 31 6 Fea & e # Frafafed @ o191 9w s 76 82
Ans X' A I gl &1 S SR (Use quotation marks)

« B. Sifed T < o7 JUIRT ST (Use complex search terms)

X C. fafry Fias o1 ITTNT BT (Use specific keywords)

X D. GTCIeIH?fsTrFT CAKC L (Vary your search engine)

Question ID : 396136920
Status : Answered
Chosen Option : D

Q.28 Hiehd URAT Aea® (Local Area Network) & e o fagfafaa o @ #19-a1 9w @ 82
Ans X A LAN &I Hdd Fage/aaR (Client/Server) dd=iids TR TaTferd faaT o Tebel B

 B. T8 3 fearsal & Siigdr § S bt vaa, Hifiya &1 &
X c. ug faftr 3= & G} fearsst &1 v WaieH giar g
2 D. WAN &% LAN &1 U& 1Y FHae -Tal R Gl g

Question ID : 396136940
Status : Answered
Chosen Option : B

Q.29 MS-Excel 365 # gheiie &) fiic B &1 I fapey Fafafaa & § s-a182

Ans & A File -> Print
< B. View -> Print
< C. Page Layout -> Print
Z5 D. Home -> Print

Question ID : 396136923
Status : Answered
Chosen Option : C

Q.30 ot oft T §-A9 (e-mail) Y1 forad Twy ad+t Sirg Flaen & 9 w4 & e sha
(Gmail) ¥ fFrafafeaa & & #9-91 96 fAipea 82

Ans g A SfE > 9 sl Wi > SRa > WeRr

(Settings > See all settings > General > Spelling)

X B. &y > I aifd ¥ > daey > Wi

(Settings > See all settings > Labels > Spelling)
X c.afw > ot 3ifq e > dee > A

(Settings > See all settings > Labels > Language)

X D. ey > dt o e > SR > daw

(Settings > See all settings > General > Language)

Question ID : 396136910
Status : Answered
Chosen Option : D
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Q.31 MS-Word 365 ¥ Wi g4 fi-} g&@@R (Mini toolbar), S 39 39d Jd, I UT HIad & Age-
e B3 T uehRia giar & forg amu feeiie = amgd g, # Seiie’ (Delete) APy &
e ®ea € @ Fafafaa # & F9-a1 e Suasy T8 giar 82

Ans X A f3clie A9 (Delete Rows)
X B. f&dilc ®Ia™ (Delete Columns)
X c. fediic 9 (Delete Cells)
« D. f&diie Uor (Delete Pages)

Question ID : 396136938
Status : Answered
Chosen Option : A

Q.32 MS-Word 365 ¥ fAafuiad o @ Si4-a1 fawey, fodl 0w & qense 3R file faseal &1 9e
A § SUANT fHaT S1aT 82

Ans X A R (Review)
X B. f&SE (Design)
« C. U Yesy (Page Setup)
< D. 3l (Draw)

Question ID : 396136934
Status : Answered
Chosen Option : C

Q.33 e B F1G701 3BTS (control unit) F Ty & FaffEa & @ Fi-ar qw /@ 22

Ans X A T8 BERI I AR UTed Rt B, It SR dvcll § SR HER b FaTad &l (e R
H 3

 B. I8 3T &I TR 3R TR &t B
X C. U8 $R ! Tt 3BT BT Ue SR TG Hdl ol

X D. U8 SR BT 31 SHITN & g a1 3R M & gxioror & Fafd s & forg
fSreR g1 81

Question ID : 396136955
Status : Answered
Chosen Option : D

Q.34 Ms-Word 365 ¥ fRaferfad d | frw 3o #f 0w ai$H (Page Borders) fased Iuasy g1d 872
Ans X A U (Review)

X B. 3R (Developer)

X C. 8 (Home)

o« D. f[&H1S (Design)

Question ID : 396136936
Status : Answered
Chosen Option : C
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Q.35 fgferfad # A H19-M AU, BEa-ags se3e MHIHRR (five layered internet
architecture) H Iuasy =|'Eﬂ Eﬁ?ﬂ %?

Ans X A TRIUIE (Transport)
X B. Sl fdi@ (Data Link)
« C. A (Session)

X D. Tf@IHTH (Application)

Question ID : 396136941
Status : Answered
Chosen Option : B

Q.36 ﬁaﬁ%@aﬁﬁﬁﬂ-m TR 71 98 YT U § W GTSAWR F TTY S (interact)
A1 8?2

Ans X A SfigE (GUI)
« B. 0 (Kernel)
2 C. 2 (Shell)
X D. TR (Editor)

Question ID : 396136945
Status : Answered
Chosen Option : A

Q.37 MS-Word 365 ¥ f&at 1t T0g 00 3R fdST (Help Viewer window) @lert & frg
Frafafaa & 3 5 SaRA-$RmT (function keys) BT ITANT f3aT SiTaT 82

Ans o A F1

X B.F5
X C.F10

X D.F4

Question ID : 396136932
Status : Answered
Chosen Option : C

Q.38 g%%xcel 365 7 9a & AR s1ear &) yfawiia o & R fFufafaa & ¥ s=-araa
?
Ans 2 A fARS S1ERT ! Tolae BT TR U AT 31eRT HT €18y e

X B. 9d T faads BT IR B SH20 ga T
X C. ¥a ¥ fFee &1 3R fOhR U 31&R </=T &
X D. 9a ¥ faee o1 3R i fSafie (Delete) F1 gamT

Question ID : 396136928
Status : Answered
Chosen Option : A
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Q.39 THTH-uTaRUTse 365 A el Uuiex # foy onrd ol ot s1em & forg Frafaf@a & &
& A7 1 SuaT S e 32

Ans A T (Insert)
X B. ISR (Transitions)
2 C. THARA (Animation)
< D. f&S=H (Design)

Question ID : 396136911
Status : Answered
Chosen Option : C

Q40 fFEfiafaa & § FF-a1 ATy, WeR iR a & 9 Ja) o31a 3R Twa aread §
T® § SR IECT & gRT wTw e Sirem 82

Ans XA 3-3hy (e-office)
X B. -7 (e-money)
X C. 39999 (e-business)
o D. SF-TIE&H (e-governance)

Question ID : 396136949
Status : Answered
Chosen Option : D

Q.41 THTH-UTGRUTSE 365 H AARS TR & Bl 3w gga & forg Frafafea # @ fFa
iwe BTN (keys) BT IUANT farar Srar 872

Ans X A Alt+G, H
X B.AIt+N, S, H
o C.Alt+H, F, S
X D. Alt+W, Q

Question ID : 396136914
Status : Answered
Chosen Option : B

Q.42 mﬁﬁﬁﬂ-ﬁaﬁtw,ﬁﬁzwuﬁqﬁamﬁaﬁvwmﬁmm
2

Ans X' A 3-0d (e-mail)
X B. 3e3c Ra T (Internet Relay Chat)
& C. disflanstt (VoIP)
X D. e (USENET)

Question ID : 396136942
Status : Answered
Chosen Option : C
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Q.43 3 deTEe) W gH Had e 1d €, 39 W 2iear § AfdAe (navigate) F34 & forg
fFrufafea & ¥ o9-a1 e e s adfe1 32
Ans XA sm?h?ﬁr (Downloads)
X B. 8%} (History)
« C. ﬂv_dﬁ?ﬂ (Favorites)

< D. 8 (Help)

Question ID : 396136921
Status : Answered
Chosen Option : C

Q.44 MS-Excel 365 ¥ GfRT (rows) FT ATHR dea- & e 9 7 A fra fywew &1 3w
forar ST 82

Ans X A B ->3¢ > fagy ar grse
(Home -> Insert -> Row Width or Row Height)
« B. 81 -> BIte -> X fIgy a1 A g8
(Home -> Format -> Row Width or Row Height)
X C.3H -> 99 T -> 3 fagy A gse
(Home -> Cell Styles -> Row Width or Row Height)

X D. Wifc Ual ead -> Bie -> A gy a1 A g13e
(Format as Table -> Format -> Row Width or Row Height)

Question ID : 396136929
Status : Answered
Chosen Option : D

Q.45 MS-Excel 365 BIH@AT # Ui (row) 5 ® Tt Aal &1 Hefia o= & fore Fofafea & 9
forareT SuaT foar wirar 82

Ans X A. $5%5
o B.55
X cC.5
X D.5$5$

Question ID : 396136930
Status : Answered
Chosen Option : A

Q.46 fT9 (Linux) TS Uldad SMTURfAT RIREH (portable operating system) gla1 81 fAaferf@a
k| abfl;-m ey e & MERITRIE W (portability feature) HT TaH 3e3T Ui
PIAT 82

Ans X A foFET (Linux) U6 g 990 § Aecudl o &1 JUIE o) Tabdl ¢
X B. a9 (Linux) T & 990 B &3 HIRIHH! $I TUIE HR 9ol g
X C. foFad (Linux) GUI & UIE o TehdT B
« D. oA (Linux) fafta TR & gr8amR W & o Iha g

Question ID : 396136946
Status : Answered
Chosen Option : A
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Q.47 fmfefad # @ S1H-a1 faeey, 3T ¢ Sy B GadT &1 94aiaH 9ol Ha1 22

(i) I STIANT ST (Run dialogue box) ¥ 1R ATH & faAT "WinWord.exe” &1 218U
P 3 ‘OK’ W fFad HY¥
(i) ¥ AN ST (Run dialogue box) T P AP & AT "Word.exe” HY CER) Y
3R ‘oK’ W s &Y
Ans X A (i)-9d (i)-9d
X B. (i)-310 (ii)-3r9d

X C. (i)-39d (ii)-gd

& D. ()-T (ii)-3r

Question ID : 396136931
Status : Answered
Chosen Option : C

Q.48 THUH-UTGRUTEE 365 H WSS Bi CITOI WIS (transition speed) T Ve A & forg
fFafafaa & 9 5 e w1 3w fsar s g2

Ans X A TFERAT (Animations) -> X% (Duration)
X B. W3S I (Slide Show) -> SRR (Duration)
o« C. TifST=M (Transition) >8R (Duration)
X D. f&m3T (Design) -> SR (Duration)

Question ID : 396136917
Status : Answered
Chosen Option : B

Q.49 MS-Word 365 ¥ fiie Mg (Print Preview) & gl # frafafad & @ #19-91 $y= 90 82
Ans A TS (Word) T gt fdst H fife (Print) 3R Wieg (Preview) P Siisdl g
X B. WIgd (File) > fife (Print) & faded $37 W, a18 3MR, 3MUa! fife (Print) 92 3R
PIPTR B AT VT (Settings) faams it
X C. ¥ (Home) T¥ & TREN% U H, 89 Had % fAfa ggi &I flic & (printing only
certain pages), J§ 3ifNfa=IT (page orientation) FGa 3M1fe S fadmed! &1 T HR T&Hd g

X D. ®I5d (File) > flie (Print) B foad &R W, 913 31, 3! 30 Yol &1 ey faars
il

Question ID : 396136935
Status : Answered
Chosen Option : D

Q.50 fAmferfad # | H-91 BIRATT [dPH ey THTI-UTaRUISE 365 H TRT I qISfST aiad
(bounding box) a?ﬁ'q, frsaar EITE'H'\EWﬁS?IT%?

Ans (A, s &ﬁ?ﬁjﬁﬁﬁﬂ (Add or Remove Columns)
X B. TRC SRIRGRM (Text Direction)
X C. FafaT 3k §aeH (Numbering or Bullets)
o D. TaTSH TRE (Align Text)

Question ID : 396136916
Status : Answered
Chosen Option : B

Section : General Knowledge Awareness
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Q.1 YRdg Hfau™ F Fafafaa § @ o9 @ dfum s siftfergs # &y § dfeu=
P TP AMRIPINS UTe & T yraur= far mar 3k gg wfau & & dwmwu & g9+
P AUAT UG BT 872

Ans X A Sfgum (@gsal g=ned) ifafgH, 1990
X B. Ty (3wewrar G=nem) siffaH, 1992
o C. Tfaum (srgraiat T=ie) sifafvad, 1987

X D. Tfaum (Ie<Ral giyE) Sifdifem, 1991

Question ID : 396136971
Status : Answered
Chosen Option : B

Q.2 gwﬁﬁm#ﬁ?mmﬁmﬁwmum(maraja|)ﬁ7admﬁﬂ-q‘umﬁ
?

Ans X A UiSd 39
o B. I dN
X C. RAr dx

2 D. Uccid 91

Question ID : 396136958
Status : Answered
Chosen Option : B

Q.3 YRd F APl F TG H, TP RURae & dic o1 9, [0 31 TT6S S ua! [Ur
T ¥ fauras! o1 TeIm A fauiford #3e iR 399 UTe YRTGd &I I
favrra s Muffya fear smar @1

Ans X A.100
« B. 1000
2< C. 100000
2 D. 10000

Question ID : 396136975
Status : Answered
Chosen Option : C

Q.4 = 2022 #, Faffed & @ 5 s § wRige T TP e e ok sfiewd (GsT)
HUGTAY BT 3gUIe [ dT T-T UT?

Ans g A TIE
X B. B

/< C. 3 H

X D. 4R

Question ID : 396136978
Status : Answered
Chosen Option : C
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Q.5 :n@amzrﬁwwﬁzooo o Riy a1t wwgar & Fafafea ¥ 9 e wa 3t gars ot
?

Ans X A TIA
X B. ditam
& C. TGl
X D. Higulgs!

Question ID : 396136957
Status : Answered
Chosen Option : A

Q.6 URA - gud (US) IRy =T I 39T BT 1391 TP ‘T9 UER, 2022’ o Ju=
gl

Ans g A ShdlE
X B. IidQR
X C. YR
X D.g0

Question ID : 396136977
Status : Answered
Chosen Option : B

Q.7 gz fRufa forad fedft srdegawur & w9 Fiud oMy dR W 9¢ 9t § iR g1 &1 59
g fiRem@re,_ seadisl
Ans X A THifd-TTieRIY

2 B. 3fawpifa
X C.geag™
& D. aRwifd

Question ID : 396136967
Status : Answered
Chosen Option : D

—
Q.8 yyW Ugqua aieHT $I HHRI: Aférd R e e g 71 A2
Ans X A 2.4% 3R 4.1%

o B.2.1% 3R 3.6%

X C.4.1% 3R 2.9%

X D.3.6% 3R 2.4%

Question ID : 396136968
Status : Answered
Chosen Option : A
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Q.9 frgferfad # A #1991 32 a1 IR (Barak Basin) ¥ 2fire 781 82
Ans X A HHR

X B. WRd

& C. AU

X D. SR

Question ID : 396136963
Status : Answered
Chosen Option : A

Ans X A JHTTTG
X B. R HG
« C. I\ 7Y Fifdg
X D. {fiq 2me

Q.10 10 3rie 2022 FY ToRTd A AP ATUIR AR BT IguTe FHufafaa & & fram fmar?

Question ID : 396136979
Status : Answered
Chosen Option : D

Question ID : 396136969
Status : Answered
Chosen Option : B

Q.11 YR gfayfar 3R R 9IS FT T MRANIR S @G IMEA S AEAE
s R-wifaftre e & wu § fear war ur
Ans X' A 30 SFaRl 1992
« B. 12 30id 1988
X C. 23 fgdaR 1990
X D. 15T 1988

Q.12 TRaTE e §% (Asian Development Bank) ST J&ITerd o 321 & fRyd 82
Ans X A RFTTQR

X B.URdS

X c. fquqam

o D el

Question ID : 396136966
Status : Answered
Chosen Option : D
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Q.13 PR A g g & EF-u-gargr s TP U 4 & v fauR &1 AR e & e
gaTel g AW O1 & Rigds o™ few 32

Ans X A 1569
X B.1574
X C.1567
« D. 1579

Question ID : 396136962
Status : Answered
Chosen Option : C

Q.14 fFgfifaa & | e gra STe=me & AR F1d F SR 1579-80 W et gt & et o
fagie gaem um?

Ans X A gAY
X B. ¥R
X C. et
o D. 3HR

Question ID : 396136959
Status : Answered
Chosen Option : B

Q.15 frmfafea & 3 e ant A s 3 o o ufdy §re Ft Ffaefadt Ht gerar?
Ans X A SIYQR 3R TS

 B. sRIael-fIeret ant

X C.3WIa-HRE "Rl

X D. SNTa-faRreTR At

Question ID : 396136964
Status : Answered
Chosen Option : B

ae mf{gaﬁawﬁﬁm%wa@zm(ad hoo) i o gk &
Tafid g2

Ans X A 3TwE 143
 B. 3=8 127
X C. 3Tw5¢ 130
X D. 3fTx5¢ 152

Question ID : 396136974
Status : Answered
Chosen Option : A
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Q17 Fgfifad § & 4Rd ¥ GRY ST ST |1 HRT AU & Hala 272
Ans X' A HTTXV

X B. YT XVI
X C. T XIV
" D. HIT XVII

Question ID : 396136972
Status : Answered
Chosen Option : B

Q.18 3[R 2022 ¥, HRT Ty HERIT (AFI) 7 YRAHT Afgen vyl &1 qnda $1 &
o fre TR & 1Y SO A HIRTar @1 Tvon @12

Ans X A O B 39 TS SO (JP Morgan Chase & Co.)
< B. @Efv{ S 311w & AT Hex=H (Central Bank of the Russian Federation)
X C. ﬁﬁ?ﬁﬁfﬁ?\ﬂ% S BruReH fafes (Sumitomo Mitsui Banking Corporation Limited)
 D. T ETHIT U3 3urs SfehT HIaR=H fafiiee (The Hongkong and Shanghai Banking

Corporation Limited)

Question ID : 396136980
Status : Answered
Chosen Option : B

-

Q.19 %r;rﬁaﬁﬁaﬁé’r% H WA 99 AF URA & TYH YHY VRS ST Sgared
I

Ans X' A RO
/< B. 3fgHAIEIG
X c.qa
o D. 4

Question ID : 396136976
Status : Answered
Chosen Option : B

_—

Q.20 ;ﬁﬁﬂ'ﬁa U9 WISH (Development as Freedom)' J&® & A@® YR femeedt
|

Ans X A HicH Rig seartern
< B. ST $UR IFREL
2 C. 3ifta i
 D. 30

Question ID : 396136970
Status : Answered
Chosen Option : B
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Q.21 TgTe Mieh B ugel IR ATeRud deat Ja § o af e fear man ure
Ans o A 1922
X B. 1920
X C.1924
2 D. 1930

Question ID : 396136960
Status : Answered
Chosen Option : C

Q.22 R (Narita) SiaRTER gaT$ orgT Frufufea & @ fra gw AfR@ 32
Ans X A @R

 B. STUH

X C.ZSHRmr

X D.dH

Question ID : 396136965
Status : Answered
Chosen Option : C

Q.23 T 2021 FT I TR TYAIE 3T g TR REHR fadar fRars), Fafifea ¥} s 82
Ans o A T XdigA dior=

X B. 3fteR urd Rig

X C. dfed $HR IureEr

X D. TS BB

Question ID : 396136981
Status : Answered
Chosen Option : A

Q.24 fomfafaa o A forw 3¢ o o ded ST 1028 Yo &2
Ans X A UM AT

X B. 3{yddg

« C. 3G

X D. TR dg

Question ID : 396136961
Status : Answered
Chosen Option: C
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Q.25 |3 (TaTaar SxityE) sifufaw, 2000 & Ao | Tal-§fEaT aqer & g smReor
Had_ q% g fear T ATl
Ans X A.2025

o B. 2020
X C.2030
X D.2015

Question ID : 396136973
Status : Answered
Chosen Option : A

Section : Reasoning

Q.1 gfe i iy 7T sigRY Ht SIS quivTar Saen § 91¢ A I1Y S9Th I & RIS HH o
SafRud fbar STl €, df 91U & Ugd, Uigd, Urdd, IRed, Jiaed, JReEd R I~wa &1
SUART He fag Y faseut & | 1 A1 iyl 2reg =TT o1 WHel 82 W 3IEGRT BT
IUART faar T iR SR Yd® &R &1 UGN $ad TP IR fbar 9= 21
MUBYIJRLGDOPCVZQNAHK

Ans X A.RAINING

& B. VARYING
75 C.DOING
#5 D.BOILING

Question ID : 396136987
Status : Answered
Chosen Option : A

Q.2 3T fdwedl § & I AHERTPI-WE FT 997 B ol FFaforad y@ar & vy fag (2) $
AfrATTa ) |t g

A1210, F169T, K225Y, P289D, ?
Ans X A. U316l

X B. V361l
X C.U361J
& D. U361

Question ID : 396136984
Status : Answered
Chosen Option : D

Q.3 gfe Q&1 HSisAr 8, J B1 3 A o HAT ], T H1 3 W R g B, 3R K &7 3rdf
| U &A1 §, ) Fuferfad sisie &1 A1 o1 g2

306 K9Q37J8T47
Ans & A.301
& B.317
« C.283
2 D. 289

Question ID : 3961361024
Status : Answered
Chosen Option : D
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Q.4 U T famedl § & IH SHERTH -G $T 997 B ol Fafrad @ & vy fag (7) o1
wfaeTiia #x w&ar g1

12P, 18T, 25X, 33B, ?
Ans X A 42E

o B.42F
X C.41F
2 D.39D

Question ID : 396136982
Status : Answered
Chosen Option : B

Q.5 7, 3T 17 21 39, R &1 frar @, Taf T, 79 9 989 21 9fS 9, R g §,
at 39 o1 T @ =T REar 22

Ans X A foar
X B. g
XCcy
& D.Ufd

Question ID : 396136993
Status : Answered
Chosen Option : D

Q.6 ?ﬁmmmﬁvﬁmwﬁwmﬁm%ﬁﬁmwwﬁwﬁm
|

SORROW : ROWROS :: DEGREE : ?
Ans X A.REEFED

/5 B. REEEGD
/< C.REEGDE
«” D. REEGED

Question ID : 3961361001
Status : Answered
Chosen Option : D
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Q.7 4R npfaai & 7 €, rd & A= feht 7 frelt v # vpanm € ok te srfa 8139
SRT SMTP T BT T B

=} =)

I 2 3 L
Ans X A2

X B.1

& C.3
X D.4

Question ID : 3961361012
Status : Answered
Chosen Option : C

Q.8 u® fAfyd He UM A, 'FOOT' H1 '56' b =4 ¥ Hed el wrar 81 St UTwT # 'coLD’ &1
59 UPR Heas fear Smem?
Ans o A 34
X B. 41
X C.43

< D.37

Question ID : 396136990
Status : Answered
Chosen Option : A

Q.9 IR I RRE T §, Rrd & ft fpelt oRe @ vrawm™ § &R U 3T 81 S SR X
BT TG B

Ans X A B
& B. T
X C.eeua
X D. @maf

Question ID : 3961361005
Status : Answered
Chosen Option : B

Q.10 I fydey H1 997 B & A T A I yHR Fafla ¥ I g den ugeh e §
el 31
64:2048::84:7?
Ans X A 3378
/< B. 3488
" C. 3528
75 D. 3890

Question ID : 3961361019
Status : Answered
Chosen Option : C
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Q11 IR 3ieR-uqg fRr e &, fd @ fi frsft 7 5wl =0 A vrauE & ok U siTa 31
I ST HER-ITHE BT 999 B
Ans & A.GIKM
X B.0QsU
X C.BDFH

« D. PRSU

Question ID : 3961361003
Status : Answered
Chosen Option : D

Q.12 e T3 e uro 4,
A#B HTATRfH A BB HI T,
‘A%B BT A B THE,
A&B PTATEfF A BRIOATS,
'A@B FTAFfFH A BHTUE T
IE'T@U&ER%S#G' &l THIG A Fa1 R=ar 82
Ans g A TTEIEHT

X B.fuar

X c.urg
2 D. HI/ERT

Question ID : 396136997
Status : Answered
Chosen Option : C

Q.13 IR Y77 R Y §, o A i it 7 ol =0 o v € ok te sRia 8139
ST Xeq-7 BT TG B

Ans X A. GEIS-TTG-[UEMT (Roar-Mew-Bleat)
X B. Hig-giqa-a18T (Den-Nest-Barn)
X C. Ba-Sifeth-faed! (Whale-Dolphin-Cat)
o D. W-W-ﬁ@_—{ (Garage-Car-Kitten)

Question ID : 3961361006
Status : Answered
Chosen Option : A

Q.14 mmﬁ?ﬁﬁ@raﬁwﬁﬁwﬁﬁaﬁﬁa e § gyaras fag (?) 3 ufawiiia
G I

1695, 1598, 1521, 1464, ?
Ans X A. 1437

« B. 1427
2 C. 1489
X D. 1414

Question ID : 3961361015
Status : Answered
Chosen Option : B
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Q.15 TR FEIy & 7 g, foeE @ fiF el 7 ol o A veuHE € ok te T ®1 99
SRITT AT BT I9q BI |
Ans 7 A 105
X B. 119
X cC.85

X D.51

Question ID : 3961361021
Status : Answered
Chosen Option : A
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Q.16 TR 3&R-TYg fr e §, ford ¥ i farsht 7 farsht =0 & vraw= § o ue e 31
I ST HER-TYE BT 999 B
Ans X A.INS
X B.AGM
X C.ELS

« D. DHM

Question ID : 3961361004
Status : Answered
Chosen Option : D

Q.17 mmﬁ?ﬁﬁﬁaﬁmgﬁqﬁﬁaﬁ@amﬁumﬁ%maﬁm
L3 [

1654, 1671, 1705, 1756, 2
Ans X A.1842
X B.1874
 C. 1824
X D. 1804

Question ID : 3961361014
Status : Answered
Chosen Option: C

Q.18 I g HT T4 B3 91 fT M fRT & 31gRY T Ia- & IR ITANT B ) a1 oI
Foar ¢ Rt IR 3 K d e &
HJWKSLPEUTNRAOCB
Ans X A . KNOW
X B.PENUTS
« C. PETER
X D.WEST

Question ID : 396136985
Status : Answered
Chosen Option : D
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Q.19 9R TE § 7 ¢, R @ A feht 7 fnxft =0 & T § 8k TP R §1 39
ST ST BT T B
Ans X A 224
« B. 362
X C.168

X D.288

Question ID : 3961361022
Status : Answered
Chosen Option : C

Q.20 3T 7Y faweal & | IH TSI &1 994 B, &l Fuferead g@ar § yyaras g (2) o1
wfereufa w= Fadt 81

4,15,41,134,7
Ans X A. 457
X B.754
X C.745
o D. 547

Question ID : 3961361013
Status : Answered
Chosen Option : B

Q.21 I feeq &1 977 Y Sl T g A IH YHR Tla 2 9 GERT Ueg U g &
e B
W:W::Eﬁ'ﬂﬁ:?
Ans g A fafsar
X B.WaR
X C. %

X D.Tg

Question ID : 396136999
Status : Answered
Chosen Option : A

Q.22 9R 3 fou M &, ForH | i freft ave A vraHE § iR U SRiTa 81 39 SR Wsg
BT TG B

Ans }(A,Uﬁ
X B. fedmm
X c. iR

« D. T

Question ID : 3961361002
Status : Answered
Chosen Option : D
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Q.23 ﬁqwﬁ?ﬁﬁﬁﬁmgﬁucﬁm@amﬁuwﬁ%(?)ﬁm
L |

2134, 2153, 2124, 2163, ?
Ans X A 2202

X B. 2143
o C.2114
X D.2212

Question ID : 3961361016
Status : Answered
Chosen Option : C

Q.24 us fAfya ge urw 4,
A+B BT H A BHTHE,
AxB BT ASEF A BBIUATE,
‘A+B BTAS g F A BITUE T
gfg'M+Nx P+ Q' §, 9 MPTQ &1 =ar g2

Ans g A T57
< B. HIdT
X C.uclt

X DR

Question ID : 396136995
Status : Answered
Chosen Option : A

Q.25 IH IR TPTa BT T B &l U= MPTal ¢ A S THR Aeifera 3 o yor 7= smpfa
B W STHfd A & Haiftd 71

Problem Fig.

% | 3]

A
Answer Fig,

W | A0 | 1 |

1 2 3 a
Ans X A.1
X B.3
K C.4
& D.2

Question ID : 3961361007
Status : Answered
Chosen Option : D

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode1/1258022443/1258022443S1D34/16690284589713201/1116117...  26/64

?@ Teachingninja.in



12/7/22, 5:18 PM https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/125802244351D34/1669028458....

Q.26 I fAPHTT BT 7T B Y X Weg A I UHR T fUd § AN gORT g Ugd Aeg A
wafta g1

Hie T : g1t :: ReR : 2

Ans X A THf

X B. 3l

 C. Rt

X D. grdir

Question ID : 396136998
Status : Answered
Chosen Option : C

Q27 gy x BT -8, + BT AT + B, + BT AT = B, s - P13 x B, A Pff@a F A S W
eI |gl 82

Ans G A 36+6+3x4-7=10
K B.46+18+9x8-9=23
K C.76+9+3x2-4=83
K D.35+7+6%x6-8=83

Question ID : 3961361026
Status : Answered
Chosen Option : B

Q.28 I fATwey HT T4 HY & Uil TE A I THR T fid 3 97 g Ten gl T A
Faftra & ok el e ddt e | welte B

15:90::29:319::34: 7
Ans X A 120
« B.238
/& C.364
& D. 302

Question ID : 3961361020
Status : Answered
Chosen Option : B

Q.29 ABCDEFGHIJKLMNOPQRSTUVWXYZ

g U, R, UiEd, B9, IRE, J5REd IR 3TAd JERT BT TP riyef 2 a9 &
fRIQ 711 1A 8, 9 W R W B AT &R my? Tt g gu sierRY &1 Iua fma
ST 91T 3R U® 31&R BT IUART $ad U IR a1 ST gl

Ans X A A
X B.L

« C.R
X D.E

Question ID : 396136986
Status : Answered
Chosen Option : D
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Q.30 I FAPHT BT T B N NI TSI | IW THR Vel 8 S gast W ugelt T
el g1
37:55.5::29: 7

Ans X A 465

« B.435
X C.455
X D.415

Question ID : 3961361018
Status : Answered
Chosen Option : A

Q.31 gqﬁmmmaﬁwhmuzﬁwﬁmm%aﬁwwwﬁwﬁm
|

SIRIUS : TVJSJT :: FELINE : ?
Ans X A. GEMJOF

X B. GEMIOF
« C. FOIMFG
X D.FOJOFG

Question ID : 3961361000
Status : Answered
Chosen Option : C

Q.32 ¥R amepfaat € ¢ B, e & 4 et 1 el =0 A vpen € R v s §1 9w

ST TP BT T H1 |
1 2 3 4
Ans X A 4
X B.3
KcC.2
 D.1

Question ID : 3961361010
Status : Answered
Chosen Option: D
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Q.33 7frdia gl & 39 W) TS &1 T4 33 o) * RIgl &) Bfie U ufawuid 3%
fFrafafaa ez i A & e gl

(17*4)*225*15+*83

Ans o A X + 5 =

FB.+ 4+, x, =
K Co— 4=
K D+ o+ %=

Question ID : 3961361025
Status : Answered
Chosen Option : A

Q.34 9R 3npfaai & 7 €, s A A7 et 7 et v & vpanm ¢ ok te sra 8139

ST TP BT T B
| 2 3 4
Ans X A.2
X B.4
x C.1
' D.3

Question ID : 3961361011
Status : Answered
Chosen Option : D

Q.35 % fAfid $e YT &, 'HUSBAND' %1 "ANDBHUS' foraT SiaT 81 33t 4o & 'KITCHEN'
P Y forar wmem?
Ans X A.HENDKIT

2 B. HENCKTI
& C. HENCKIT
' D. HEMCKIT

Question ID : 396136989
Status : Answered
Chosen Option : C

Q.36 T A e Ut &, 'MONK' ) '212' & =U & Heas fbar wirar g1 My & ‘oG
P! 5 YR Feas foar smem?
Ans X A 34

X B.112

o C.67
X D.78

Question ID : 396136992
Status : Answered
Chosen Option : D
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Q.37 us fAfda ge utar A,
A#B BT fH A BHIHIT,
‘A% B BT Af g fF A BHTRAT S,
‘A&B HTITZMF A BHTEIT,
'A@B PTATfH A BITUE I
AR MU NE&P#Q@T & I MPTT & o7 =T 82

Ans X A WS
X B.ofd
K CT
o D. TUa

Question ID : 396136996
Status : Answered
Chosen Option : D

Q.38 faE Y faweul # ¥ SH JERIPIY-HHE T 994 1 ol (Huforad y@or d vy f[&0g (7) o7
wfrTia H) Far 3

45C, 54G, 48L, 57R, ?
Ans X A 62X
X B. 66X
X C.532
 D.51Y

Question ID : 396136983
Status : Answered
Chosen Option : D

Q.39 uw fAfdd He uTaT &, 'RKSTPN' ®1 '131178169' & w0 ¥ Geass [har war g1 It urer &
'NLTRHP' &1 {5 ¥ USR Heds foar smgm?
Ans X A 14122018816

& B. 1119971513
75 C. 1315791911
#< D. 11199201513

Question ID : 396136991
Status : Answered
Chosen Option : A

Q.40 mmﬁﬁﬁmqﬁqﬁhmmWﬁuwﬁ%mﬁm
Ly |

4532, 4316, 4191, 4127, ?
Ans & A 4112
X B. 4119
& C.4118
& D. 4100

Question ID : 3961361017
Status : Answered
Chosen Option : D
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Q.41 IR 31pfa § 7% 3, ored | Fi7 faeft 7 felt 8% @ v ww § ok v arivra 31
ST TP BT T B

Ans

KA

« B.

Question ID : 3961361009
Status : Answered
Chosen Option : A

Q.42 I IR AP BT TIT F¥ o YA P C H I YR Wafla 8 for o u=A spfar

B U= 3MPid A ¥ Wafta g1
Problem Fig.
X [£]F] -
A E c D

Answer Fig,

2RI

1

(]
"
=

Ans X A2
X B.1

& C.3
X D.4

Question ID : 3961361008
Status : Answered
Chosen Option : C
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Ans XA.@
& B. ol
X C. ycier
X D.Ual

Q.43 gsﬁwaﬁ%‘,wﬁwsﬁvomﬁl S, PHI YA 3R N &1 UTE 81 M BT Q A Fa1 e

Question ID : 396136994
Status : Answered
Chosen Option : B

forar smeam?
Ans X A.DCMGE

« B. DCMGF
% C.DCNGF
< D. DDMGF

Q.44 tw i $e UMW §, 'CHIEF' ®1 'EJKGH' forar wirar 81 30t |TaT & 'BAKED' &1 9

Question ID : 396136988
Status : Answered
Chosen Option : B

Q.45 IR wEIg § 7 ¥, R & i Rt =1 et w0 F g ¥ iR U oA §1 9w

SR BT BT TG Be |

Ans o A 267

< B.223

X C.21

< D.233

Question ID : 3961361023
Status : Answered
Chosen Option : A

Section : Gener 1di

Q.1 e geraw gAHR, FHuffaa o ot gfd sifvm-
- 3T AqTpa 98 Pe e 8, a0 M omud ey gonawadt &y

Ans X A SG0 P OIS
« B. 9134 didl U1 =it
X C.aq @ Hid
2 D. SIaA-8R

Question ID : 3961361049
Status : Answered
Chosen Option: C
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Q.2 fgfifad d A frg Rew & geray o1 1a s 82

Ans o A TR 1 380 81 ART A el & Fgel e o
X B. 39 391 g1 H 3FIY MIPR 9P TR st H RTeht o 281 8]
X C. 31T T gravdl o &R H51 US 381 § o ga- a1a-aret ot foRian & |
X D. TR &R $H Pieadl § TS BIs oI 7, $S Ud o el Iardl [ &d g1 71|

Question ID : 3961361050
Status : Answered
Chosen Option : C

Q.3 fafafaa ¥ J f5a Fy= F e <6l A v € gam werad Iuge 22
Ans o A T ST A5G A TP IIE b Ufded 1 $1 FHN UG, Al , b
Tz § R g1 €t 3maT & Y Wee, Ao TR T § |

X B. A T T SN, BT AT g3, U B A1 DS gl oI Wbd,
X C. gy alv gHem ¥ 9 § 8T 31, 3% W peR qus € 3fay,
X D. 3 THSITT Afp I 30 RIS A1 Yol I H A AR e R,

Question ID : 3961361054
Status : Answered
Chosen Option : A

Q4 FEfifed e & I ardd? & gatgard o1 9949 -
Ans X' A AT

 B. 3mulf

X c.3fe

X D. URdt

Question ID : 3961361071
Status : Answered
Chosen Option : B

Q5 e &1 gud Wt Iga o T diwied o1 a9q o3-
Ans X' A T AT, e Wl

« B. TC T 1 TPI

X C. AT e FHora &

X D. ¢ SRl 3 4R d8f B

Question ID : 3961361056
Status : Answered
Chosen Option : B
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Ans & A UIOA

X B. Ry

X c.a™

X D. TR

Question ID : 3961361067
Status : Answered
Chosen Option : D

Q.7 frmfiafaa o & q SI=[E a1y BT a9 BHoR-
Ans X A ITF R 3T 8 Fah! quny |
X B. THIER fd & U Yad A € uaid gt 3
X C. e 7 gy SR deb RT3 B
« D. TH A7 & a9 de?

Question ID : 3961361037
Status : Answered
Chosen Option : B

Q8 gAY g 3 e i 39 T vew € v v
Iude ared & fbg wIT § argf 82

Ans X A T TR TR
« B. T EW &
X c. s
X D. g difoi

Question ID : 3961361027
Status : Answered
Chosen Option : D
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Q9 frafufld el & A g are B g FIA-

Ans A 3T TRE DLIId G- IRT B UH 71
X B. At $IE Bt 3d U 317 B 1 9 I o ot 7
X C. 3o il 31 I §, I Sau™ B 3
X D. 799 7 U fa R fawm a1 <ff g

Question ID : 3961361038
Status : Answered
Chosen Option : D
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Q.10 N F ST 19 T GeTar F T GETa &1 797 -

A Tl & S ERT @
X B. Hd &I gari ARAT
X C. e o fofer e
X D. U & 4R d F8T

Question ID : 3961361048
Status : Answered
Chosen Option : D

Ans

Q.11 frafafea § & fea deifen o1 o Tafl F31 A T PgA M & 82

X A e ardl 3get 99

o B. ST WD UR

X C. {5 g S8, ITHT 9 Dl
X D.IRTARIAAT

Question ID : 3961361052
Status : Answered
Chosen Option : A

Ans

Q.12 Fmfafed are & s YT ST 79 Hiford-
Tl B qToT T BT g IR Y o freran 3

& A. TSI T &1 gY
X B. 3R ga

X c. aag

X D.3UTHH

Ans

X A. Iqgm
o B. JUTH
< C. 36
25 D. I

Question ID : 3961361030
Status : Answered
Chosen Option : A

Q.13 fufafEd s F Y= TF EY BT I $i-
T

Question ID : 3961361061
Status : Answered
Chosen Option : A

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/1258022443S1D34/16690284589713201/1116117...

35/64

3@ Teachingninja.in



12/7/22, 5:18 PM

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/1258022443S51D34/1669028458....

Ans

Q.14 Fofifaa & @ o1 91 Rew g dga- TaH gH 82

X A B - gt
X B. 3@ -ay
o C. U5 -W
X D.ga—+ff

Question ID : 3961361064
Status : Answered
Chosen Option : C

Ans

Q.15 fFmfafea o | 9 Y= a9 31 994 Fifor-

X A ST A e WL 7 |

X B. 31 & §g &1 GHER I Il ¢ R § FRmem &1 w1 |
X C. W 3R Hiar deg auif & a1g St S|

« D. 3 I8 TSR & 9 J gl g

Question ID : 3961361035
Status : Answered
Chosen Option : D

Ans

Q.16 PofifEd & @ P19-91 U< v &1 fudards 82

X A
X B.UOd
o C.UR
X D.Sfa

Question ID : 3961361079
Status : Answered
Chosen Option : A

Ans

X A Blc1 g g8t a1

X B. faq® 3t 3iie & w8
X C.qSa-8ra @t ¥ urd-urd
& D. 951 QP & I Urd

Q17 g@%ﬁmmmﬁ?wwwmwﬁmm_@ﬁ
|
SUYH wipifed gy, ara # Red ®iF 31 gfd Fifer-

Question ID : 3961361053
Status : Answered
Chosen Option : D
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Ans

Q.18 fraffea ol & | Y& a9 31 999 Fifr-

o A T80 Tcw 3 ouft BHrS 1 Siftiesier arF o faan|

X B. 9@ e 7 3u HHIS BT ARIBT T 1 & o
X C. 4@ Tiem 3 oot HHTE H7 SiftiaT=r it g A 3 faam)
X D. 4@ TIem 3 o= HHTS HT SHf¥aT=T Uit gH A § 3|

Question ID : 3961361036
Status : Answered
Chosen Option : B
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Q.19 Prafafd areg & args | B Rifga Fifve -

g ot @Y THa g 9oar & % 98 faaray 7 e 3 fis & w1y Wem T T gl

o B. IS
X C. guie™
X D. agwR

Ans X A 30H i o Ay
X B. W Id TG
X c. % g foemea 9 SR
o D. T8 4t Al Ga & ehall 3
Question ID : 3961361031
Status : Answered
Chosen Option : D
= @ —
Q.20 fagfofed & @ o faeia-gm &1 uga -
Ans X A ST — TSHId
X B. U9® — UT0&H
X C. =g -y
o D. 3Yd — 3aYd
Question ID : 3961361080
Status : Answered
Chosen Option : B
—_— = =
Q.21 IH Vg TWR F Togd FY BT 99 DI -
Ans X' A RN

Question ID : 3961361063
Status : Answered
Chosen Option : A
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& & S go g, e adp
Iad are § S T URT 3T 32 Ffga Fifvm-

Ans X A TF a1 3fe Few i 1 3afad e,
X B. 30 gfaER foega Tar el @
X C.JUWW Il & iy
o D. ¥ S @Y, e aely

Q.22 TP @ e Frow ft &1 safdd €, 99 W R aTel & 1Y 501 godaeR Rrape T

Question ID : 3961361034
Status : Answered
Chosen Option : B

Q.23 T[T Weg P UGG} BT TG HY-
Ans X A farar

X B. T

X C. &

& D. 3

Question ID : 3961361068
Status : Answered
Chosen Option : D

Q.24 frgfafad # 9 o= faaw- 3w o1 g o-
Ans X A &fore — =myd

o B. 38— 3

X C. oy -y

X D.3U-A

Question ID : 3961361076
Status : Answered
Chosen Option : B

Q.25 A VS P Uit UIS TP 39 Ferad & St 3 BT 99 H-
Ans X A I G T HY IS TS

« B. T8 7 81 W I SguH fewm
X C. A & fory 18 3ur et
X D. SR Y 3T, 71 A R

Question ID : 3961361051
Status : Answered
Chosen Option : B
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Q.26 WP HyTad gey, Fafifad = $1 gfd Fifer-
TTHI- *3ToT ¥MAT g ¥ et & Y@ Y@ i ok
@ﬁ%ﬁﬁﬁ?ﬂﬁ%ﬁfﬁaﬁqywm%

Ans A f59d Ul BRI

X B. U1s TR R & T g
X C. BoaT @M ald g A ge

2 D. It T H 7Y & feran

e T1| 19 ST AT A Sier df Jedl &
gElaE!

Question ID : 3961361057
Status : Answered
Chosen Option : A

Q.27 R B BISt AT GoTd S Ifaa 3rd &1 T97 HI-
Ans X A M 3R SfgHd A I

 B. @RI I T

X C. @RI Id dAl

X D. SIS ¥ o

Question ID : 3961361043
Status : Answered
Chosen Option : B

Q.28 diar Weg & I yafgar= o1 I PI-
Ans A fUTE

X B. Uy
X c. iR

X D.4m@

Question ID : 3961361070
Status : Answered
Chosen Option : A

Q.29 fmfafaa & A fora gerar @1 o Fige TR A ar 32
Ans g A ScUid U@l

2 B. T4 g

X C. g dprel

X D. Hao R I e

Question ID : 3961361044
Status : Answered
Chosen Option : A

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/1258022443S51D34/1669028458....

https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/1258022443S1D34/16690284589713201/1116117...

39/64

3@ Teachingninja.in



12/7/22, 5:18 PM https://cdn.digialm.com/per/g01/pub/1258/touchstone/AssessmentQPHTMLMode 1/1258022443/125802244351D34/1669028458....

Q.30 Pofafed are & s I &) fafa Ffvmg -
3mq g P 3redt AR | 98 G A1 TR fF giever v @ ag Hifa suR s
FRadad e
Ans X A BIR GO & fRA A TS &
X B. 3Mg T & S Rg ¥
X C. g gug o =1feT

o D. BRI B B1 7% i

Question ID : 3961361032
Status : Answered
Chosen Option : A

Q.31 fmfiafad & | R[S ad- a1 THH g BT TG DI~
Ans o A TH

X B. 9%

X C.yR

X D. &I

Question ID : 3961361060
Status : Answered
Chosen Option : A

Q.32 frmfafed & 3 5 gerar &1 o 3T &0 g AT 82
Ans X' A 30 ST UR SRl

& B. 3T 1Y STy

X C. 3O+ TSt 3UA JIY
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Question ID : 3961361046
Status : Answered
Chosen Option : B

Q.33 fyfafa § A few area § waf 3R fpar &1 erag g= 82
Ans X A FS ASH, ol JGIT 3R $F FITHTE AgH T a1d IR I8 9
X B. <l 3R T grad =l 7 g
X C. faeeit A gy iR Has | |
o D. 3, 2item, JR SR fadeft omd ok 3 7t oft 7y

Question ID : 3961361042
Status : Answered
Chosen Option : A
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Ans X' A W[

« B. OWgH
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Question ID : 3961361066
Status : Answered
Chosen Option : A

Q.35 HfIdr U 3R ATeh 3T A UTe D 3N H1aT DI Sl SFIYRT 3R g 3= a1

‘iﬁfﬁ?ﬁ% T WYY
@‘iﬂﬁm ¥ o & FR 22 UgAE BN-

Ans X A 3y Eid g, gl vE R
X B. SRR 3R fd=-g 3 Bt
X C. BfIar ug 3R e @ I
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Question ID : 3961361033
Status : Answered
Chosen Option : B

Q.36 ee]-goe] WIUAT HeTaR & 3rdf 31 997 FIfora-
Ans o2 A UIST-YIST ST HR I

X B. UIST-ATeT M g

X C. gd G

X D. e RAT T

Question ID : 3961361045
Status : Answered
Chosen Option : A

Q.37 gl a?ﬁ?ﬁtrqmaﬁqﬁrﬁ;
Ans KA.W

" B. Taftiiur

X C. gl

X D. 3F®d

Question ID : 3961361075
Status : Answered
Chosen Option : D
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Q.38 Frafifd ¥ | few fiee & 9l e wev & wafa &2
Ans g A 3T difg

X B. AN, faumad

X C. BaR, am

X D. 347, 3ffa

Question ID : 3961361073
Status : Answered
Chosen Option : A

Q.39 fafafaa & A fea fawe & dsifwt o1 wE sms 82
Ans X A TE & IR & HER I Gt 7T § Afch ITDT il & HRU Blg I Tal
Iz, fondfl 3 w2 81 et & fob =1 ST AR 9|
X B. TS Il & U 3ot 3fpd Tufy § bR it 3ram arera B de et & R aTal § 98d $9
fore Y ST R IR §] 37 W O T8l FHerad arkard gt § far gielt SR 7Tt {5 g SR Iy
& C. ST 1S U7 3R TR1 1 @t e g 38 e €, el gr 8y
X D. 3nft AdeH & S foT It §, A SN BRI § B &, TH al 99 9d 34 3R A Bl 4R
@y

Question ID : 3961361058
Status : Answered
Chosen Option : B

Q.40 frafifRa ¥ & HI19 91 W Xaw BT qafgar T8 82
Ans g A Bd®

X B. =Y

X c.Bay

X D. fo=uny

Question ID : 3961361072
Status : Answered
Chosen Option : A

Q41 fmfifaa # | o o & o iR frar &1 sy R[S 872
Ans X A I3 SIS HH § &1 At

o« B. T TR ¥ S 3R gua Wil

X C. 3guHr & it WIS a1 uie S5 Tl #f S|

X D. 59 T & 9gd ¥ A9 SR defear oy

Question ID : 3961361041
Status : Answered
Chosen Option : B
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Q.42 frgfafaa & ¥ quir e F e e 1 a7 #3-
Ans .VA_%?IEUH

X B. g

X C.qu

X D. 3uqwn

Question ID : 3961361074
Status : Answered
Chosen Option : A

Q.43 fagfafaa & ¥ urir & faaandf wreg &1 7a= +-
Ans X A Gfam

X B. sifcH

X c.oBm

o D. UigH

Question ID : 3961361077
Status : Answered
Chosen Option : B

Q.44 g & Y IS MY, ST WA G - 59 i & Sfa ord &1 797 -
Ans X A §gI % Tgd BICI Bl RISl

X B. BEal o R € e ST U uTar 7

2 C. Tuft afeRT BT T[UT &R BTel § Webe B Sl ©

o D. Hdl AT & I WR R AN b 81U H SMUPR

Question ID : 3961361055
Status : Answered
Chosen Option : D

Q.45 fmfafea & @ frw fawen & i 2reg 9w ® yafaarh §2
Ans X A 3ffdhae, RITR

X B. faeerm, st

o C. dfe, GaRM

75 D. &, BT

Question ID : 3961361069
Status : Answered
Chosen Option: C
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Ans

X A SHEARIE H
& B. TR & DI MR AN
X C. Jufkyd g
X D. faameg 9urR ¥ smaiifsd

Q.46 fIETad GURTR § ARG 30 TURIE § 6T & 3! MUY | IufRyd g1’
Sue are F ford wmT & g 82

Question ID : 3961361028
Status : Answered
Chosen Option : B

Ans

Q.47 fgfafad & A fea o § Teg-aaT Tt gl T8 872

o A. ST TRBR BT famR & e |

X B. T8 U 3rdried Fdy g
X C. O &A1 IR B Al W T 2|

X D. B ol o1 srelt & 0 3ot yu et 3

Question ID : 3961361040
Status : Answered
Chosen Option : C

Ans

Q.48 frgfifad § A TcHH e P UG BT -

XA, T
o B. 3R
X C. U=

X D. gl

Question ID : 3961361059
Status : Answered
Chosen Option : A

Ans

Q.49 Frofifad § A T sk T Ugar ST -

X A @
o B. YA
X Cc.aq
X D. T

Question ID : 3961361062
Status : Answered
Chosen Option : C
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Q.50 famfiafad & ¥ W &1 SR UssAr ggrar &1 3frd ordf 71 82
Ans (A, TSTS Sitd ST

X B. QP &R

o C. TR T U

X D. @ & 3R 81

Question ID : 3961361047
Status : Answered
Chosen Option : D

Q.51 ed F fareliv Weg BT 9T HN-
Ans XA.E'QC

X B. HSIgd

X C. &gl

« D. FeAan

Question ID : 3961361078
Status : Answered
Chosen Option : D

Q.52 fmfifea & @ o= @ fdw- gm g 2
Ans o A T - 3

X B. 3N - 35T

X C. P -G

X D.BE-T5

Question ID : 3961361081
Status : Answered
Chosen Option : B

Q.53 ggd HHY UgH HAHT 81 WIRA B ISty AP
STIT TR &b A5 U T 999 Piford-

Ans X' A YRd DI
X B. 9gd 9Hd Ugd
& C. TSIyl At
X D. pabd gl

Question ID : 3961361029
Status : Answered
Chosen Option : C
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Q.54 3RUg Teg b Y& q1 T Aogd T BT TG PHoIQ -
Ans ?(A,‘agj

X B. RyErst

« C.3®e

X D. e

Question ID : 3961361065
Status : Answered
Chosen Option : A

Q.55 frgfafad o J feg areg § o v ergrfs 22

Ans X A UEFST H WITA®R SIcid QT SHTSHT IR 0T Mg URgd $Rd 3
 B. B Tea A YR G&pla BT $g @18
X C. TR 3 Medl & BRI g o1 G- usht g
< D. 3B IUAT UI6S H Ue 1 3 U1 3l g

Question ID : 3961361039
Status : Answered
Chosen Option : D

Section : General English

Q.1 Select the option that expresses the given sentence in active voice.

Captain Vikram Batra was awarded the Param Vir Chakra posthumously.
Ans X A. The Param Vir Chakra is being awarded to Captain Vikram Batra posthumously.

< B. The Param Vir Chakra will be awarded to Captain Vikram Batra posthumously.
< C. The Param Vir Chakra has been awarded to Captain Vikram Batra posthumously.

«” D. The Param Vir Chakra was awarded to Captain Vikram Batra posthumously.

Question ID : 3961361099
Status : Answered
Chosen Option : D

Q.2 Select the most appropriate option to fill in the blank.

It’s so cold on the higher reaches of Ladakh that some soldiers get frost-bite in their

Ans o A foes
X B. tows
/5 C.toss
< D. twos

Question ID : 3961361120
Status : Answered
Chosen Option : D
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Q.3 Four sentences of a paragraph are given below in jumbled order. Arrange the
sentences in the correct order to form a meaningful and coherent paragraph.

(A) Whenever | teach my class, | make sure that everyone participates in the question-
answer session.

(B) This way, students learn to express their opinions in front of others and the teacher
also understands how much the students have learnt.

(C) I normally teach for forty minutes and the last twenty minutes | keep open for
debates, questions and answers.

(D) Many times | have learnt a lot from my students during these sessions.

Ans X A ADBC
X B.CBDA
« C.ACBD
< D.DACB

Question ID : 3961361102
Status : Answered
Chosen Option : C

Q.4 Select the most appropriate option to fill in the blank.

They were armed knives and swords.
Ans o A with

< B.by

/S C.to
< D. from

Question ID : 3961361086
Status : Answered
Chosen Option : B

Q.5 Select the option that is NOT an ANTONYM of another word by way of adding the
prefix ‘Dis-".
Ans X A. Disconnect
«” B. Discretion
25 C. Discontinue

25 D. Discomfort

Question ID : 3961361116
Status : Answered
Chosen Option : D

Q.6 Select the most appropriate option to fill in the blank.

Mother made Avika her essay before submitting it.
Ans o A edit

5 B. editing
25 C. to edit
< D. edited

Question ID : 3961361089
Status : Answered
Chosen Option : D
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Q.7 Select the sentence with the correct punctuation and capitalisation.
Ans X A.“What's the matter? Avika.” asked Rahul.

5 B. “Whats the matter, Avika,” asked Rahul.
«” C. “What's the matter, Avika?” asked Rahul.
& D. “What's the matter avika?” asked Rahul.

Question ID : 3961361093
Status : Answered
Chosen Option : A

Q.8 Select the most appropriate option to fill in the blanks.

When | was young, | to school on my bike on a dirt
Ans X A.rode; rode

< B. road; road
& C. rode; road
< D. road; rode

Question ID : 3961361118
Status : Answered
Chosen Option : C

Q.9 Select the most appropriate ANTONYM of the given word.

Queer
Ans  # A Ordinary
#5 B. Striking
< C.Rare
#< D. Baffling

Question ID : 3961361114
Status : Answered
Chosen Option : B

—
Q.10 Select the option that expresses the given sentence in passive voice.

Havildar Abdul Hamid knocked out the oncoming enemy tank.
Ans & A. The oncoming enemy tank was knocked out by Havildar Abdul Hamid.

5 B. The oncoming enemy tank will be knocked out by Havildar Abdul Hamid.
< C. Havildar Abdul Hamid was knocked out by the oncoming enemy tank.

25 D. The oncoming enemy tank had been knocked out by Havildar Abdul Hamid.

Question ID : 3961361098
Status : Answered
Chosen Option: C
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Ans X A ADBC
X B.DACB
X C.CDAB
« D. CBAD

Q.11 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

A. This socialising habit may have been an important factor for their brains to grow
into a relatively large and complex organ.

B. Unlike many other species, dolphins live in complex social groups.

C. Dolphins are known to be highly intelligent, playful and friendly.

D.Scientists believe that it may have taken thousands of years for Dolphin brains to
adapt to survival modes and to develop to their present level of intelligence.

Question ID : 3961361103
Status : Answered
Chosen Option: C

Q.12 Select the most appropriate option to fill in the blank.

Even now, many of us
Ans X A had not understood

the true meaning of freedom of speech.

«” B. have not understood
< C. are not understanding

25 D. were not understanding

Question ID : 3961361096
Status : Answered
Chosen Option : B

Q.13 Select the option that expresses the given sentence in indirect speech.

She said, “lI sold my car myself.”
Ans X A. She said that | sold my car myself.

25 B. She said that | sold her car myself.
5 C. She said that she had sold my car herself.
& D. She said that she had sold her car herself.

Question ID : 3961361095
Status : Answered
Chosen Option : D

How long can you
Ans X A hold with

5 B. hold up
< C. hold back
«” D. hold on

Q.14 Select the most appropriate option to fill in the blank.

in this cold weather without proper clothing?

Question ID : 3961361091
Status : Answered
Chosen Option : D
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Q.15 Select the most appropriate option to fill in the blank.

She suddenly remembered that she her house before leaving for work.
Ans X A. has not locked

#5 B. does not lock
«” C. had not locked

< D. was not locking

Question ID : 3961361097
Status : Answered
Chosen Option : A

Q.16 Select the most appropriate synonym of the given word.

Extricate
Ans X A. Entangle

25 B. Remain
25 C. Connect
" D. Detach

Question ID : 3961361122
Status : Answered
Chosen Option : B

Q.17 Select the most appropriate option to fill in the blank.

The speaker was least perturbed by the disturbance in the front rows and
with his speech.

Ans X A. carried off
< B. carried out
«” C. carried on

< D. carried away

Question ID : 3961361090
Status : Answered
Chosen Option : C

Q.18 Select the most appropriate option that can substitute the underlined word in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.

We had given the patient the first support before the doctor arrived.
Ans X A benefit

< B. help
«” C. aid
25 D. No substitution required

Question ID : 3961361106
Status : Answered
Chosen Option : B
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Q.19 Select the correctly spelt word to fill in the blank.

As a Chartered Accountant, his comprises big business people of the town.
Ans X A.cliantele

/5 B. cliantale
5 C. clientale
" D. clientele

Question ID : 3961361125
Status : Answered
Chosen Option : B

Q.20 Select the most appropriate option that collocates with the word ‘dogs’ to fill in the
blank.

The street dogs made quite a ruckus when they started together last night.
Ans X A. braying

< B. roaring
< C. neighing
«” D. barking

Question ID : 3961361111
Status : Answered
Chosen Option : D

Q.21 Select the most appropriate option to fill in the blank.

looking after the old lady, | also do their cooking.
Ans X A. In spite of

< B. Although
" C. Besides
< D. In case

Question ID : 3961361085
Status : Answered
Chosen Option : C

Q.22 Given below are four sentences, out of which three are connected. Select the odd
sentence.

Ans X A. Today Malcolm and Barb live near Vancouver.
< B. They were married on 27 July 2021.
< C. Malcolm drove Barb to a jewellery shop and they chose an engagement ring.

«” D. Surgery began with a seven hour emergency operation.

Question ID : 3961361104
Status : Answered
Chosen Option : B
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Q.23

Ans

Select the option that expresses the given sentence in direct speech.

The teacher told the students that most of them would be leaving school at the end of
the session.

25 A. The teacher said to the students, “Most of them will leave school at the end of the
session.”

/5 B. The teacher said to the students, “Most of you would have left school by the end of
the session.”

«” C. The teacher said to the students, “Most of you will be leaving school at the end of the
session.”

X D. The teacher said to the students, “Most of them would be leaving school at the end of
the session.”

Question ID : 3961361094
Status : Answered
Chosen Option : C

Q.24

Ans

Select the most appropriate option to fill in the blank.

My mother enjoys Turkish series on YouTube.
< A. watched

< B. to watch
< C. watch
«” D. watching

Question ID : 3961361088
Status : Answered
Chosen Option : D

_—

Q.25

Ans

Given below are four sentences, out of which three are connected. Select the odd
sentence.

25 A. The most widely accepted explanation is that Oswald killed JFK on his own and Ruby
killed Oswald, on his own volition.

«” B. The identity of his killers and the location of his body are ongoing mysteries.
< C. On 24 November 1963, before Oswald could stand trial, Oswald was fatally shot by
nightclub owner Jack Ruby.

< D. On 22 November 1963, President John F Kennedy was shot in Dallas by Lee Harvey
Oswald.

Question ID : 3961361105
Status : Answered
Chosen Option : D

Q.26

Ans

——
Select the most appropriate option to fill in the blank.

The poor girl did nothing cry.
XA as
«” B. but
X C.so
25 D.and

Question ID : 3961361084
Status : Answered
Chosen Option : C
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Q.27 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

A.The slogan ‘Jai Jawan’ and ‘Jai Kisan’ was first coined by Lal Bahadur Shastri
immediately after the 1965 war.

B.This was coined to honour the two biggest pillars of Indian democracy: the soldiers
and the farmers.

C.It seems once again, it is time for India to relook into its policies pertaining to
soldiers and farmers

D.He strongly believed that soldiers and farmers were the backbone of Indian society
and deserved to be honoured.

Ans X A ADCB
X B.ABCD
X C.ACBD
« D. ABDC

Question ID : 3961361101
Status : Answered
Chosen Option : C

Q.28 Select the most appropriate option that collocates with the word ‘pain’ to fill in the
blank.

He suffered with pain in his head after his car accident.
Ans X A. strong

< B. robust

< C. heavy
¥ D. excruciating

Question ID : 3961361113
Status : Answered
Chosen Option: C

Q.29 Select the most appropriate option to fill in the blanks.

This factory manufactures rubber . The employees have to
special suits.

Ans X A. wear; wear
«” B. ware; wear
25 C. wear; ware

< D. ware; ware

Question ID : 3961361117
Status : Answered
Chosen Option : A
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Q.30 Select the option that completes the given proverb correctly.

can’t be choosers.
Ans X A.Paupers

/5 B. Bankrupts
5 C. Vagrants

«” D. Beggars

Question ID : 3961361109
Status : Answered
Chosen Option : D

Q.31 Select the most appropriate option to fill in the blank.

Let us meet at the coffeehouse. We can sit and have a chat a cup of
coffee.
Ans X A. above
X B.at
X C.on
«” D. over
Question ID : 3961361087
Status : Answered
Chosen Option : A
_— =

Q.32 Select the most appropriate synonym of the given word.

Incessant
Ans X A.Broken

" B. Ceaseless
< C. Infrequent
#< D. Halting

Question ID : 3961361123
Status : Answered
Chosen Option : C

Q.33 Segments of the following sentence have been given as options. One of them may
have a spelling error. Select the segment that contains the error. If you don’t find any
error, mark ‘No error’ as your answer.

Modern industrialised communities experience the joy which nature gives on
ocassional weekends.

Ans & A. on ocassional weekends.
#5 B. Modern industrialised communities
< C. No error

< D. experience the joy which nature gives

Question ID : 3961361126
Status : Answered
Chosen Option : B
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Q.34 Select the most appropriate option that collocates with the word ‘tears’ to fill in the
blank.

When she heard the news of her brother’s martyrdom, she into tears.
Ans X A. gushed

& B. burst
< C. rushed
< D. spurt

Question ID : 3961361112
Status : Answered
Chosen Option : C

Q.35 Select the correct punctuation mark to fill in the blank.

The meeting was chaired by Mr. Rao the MD of our company
Ans X A. semicolon (;)

X B. dash (—)

& C.comma (,)

< D. colon (:)

Question ID : 3961361092
Status : Answered
Chosen Option : C
_— =

Q.36 Select the most appropriate option to fill in the blank.

A of doves is nesting on my mango tree nowadays.
Ans o A pair
X B. pare
5 C. pear
< D. peer
Question ID : 3961361119
Status : Answered
Chosen Option : A
= E

Q.37 Select the most appropriate meaning of the given idiom.

Rose-coloured glasses
Ans X A.An event to remember

Z5 B. A dim view of things
< C. An outdated thing

«” D. An unduly positive outlook on life

Question ID : 3961361110
Status : Answered
Chosen Option : D
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Q.38 Select the most appropriate option to fill in the blank.

The indication of his high rank were five stars in each of his shoulder
straps.

Ans X A just
< B. much

" C.only
< D. little

Question ID : 3961361082
Status : Answered
Chosen Option : D

Q.39 Select the most appropriate option to fill in the blank.

He sketched the danger of death and destruction that hung over the world.
Ans o A still

X B. quite
< C. rather
< D. enough

Question ID : 3961361083
Status : Answered
Chosen Option : C

Q.40 Four sentences of a paragraph are given below in jumbled order. Arrange the
sentences in the correct order to form a meaningful and coherent paragraph.

(A) In India, particularly in villages, even a few decades back, women without children
were looked down upon.

(B) Such women were not invited for naming ceremonies.

(C) Nobody understood the hurt and trauma they underwent.

(D) And they were taunted as barren women.

Ans X A ABCD
X B.ACBD
X C.ADCB
« D. ABDC

Question ID : 3961361100
Status : Answered
Chosen Option : D

Q.41 Select the most appropriate ANTONYM of the given word.

Placate
Ans X A. Humour

25 B. Indulge
25 C. Comfort
& D. Annoy

Question ID : 3961361115
Status : Answered
Chosen Option : B
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Q.42 Select the most appropriate option that can substitute the underlined word in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.

When are you going to launch solar panels on your roof top?
Ans o Al install
5 B. lift off
X C. present
< D. No substitution required

Question ID : 3961361107
Status : Answered
Chosen Option : A

Q.43 Select the correctly spelt word to fill in the blank.
She got an opportunity to participate in the painting exhibition by __ artists.
Ans X A. amatuer
< B. amature
< C. ameteur
” D. amateur

Question ID : 3961361124
Status : Answered
Chosen Option : B

Q.44 Select the most appropriate synonym of the given word.
Dainty
Ans X A.Nervous
" B. Fragile
< C. Tough
< D. Annoyed

Question ID : 3961361121
Status : Answered
Chosen Option : B

Q.45 Select the most appropriate option that can substitute the underlined word in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.

She enjoys great punctuality among her students.
Ans o A popularity
< B. partiality
25 C. perpetuity
25 D. No substitution required

Question ID : 3961361108
Status : Answered
Chosen Option : A
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Comprehension:

In the following passage some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

The James Webb Telescope has beamed back the (1) pictures of Neptune, the
last planet in our Solar System, in (2) 30 years. The telescope has revealed the
icy giant in a new light, (3) 4.3 billion kilometres away from Earth, at the

(4) of the Solar System.

The telescope has picked up a crisp view of the rings of Neptune, (5) had last
been seen only in pictures taken by the Voyager 2 spacecraft when it conducted a flyby way
back in 1989. Since then, the Voyager spacecraft is flying in interstellar space, millions of
kilometres away from Neptune where the Sun’s impact ends.

SubQuestion No : 46
Q.46 Select the most appropriate option to fill in the blank no. 1.
Ans X A.clear

75 B. clearer
75 C. more clear

«” D. clearest

Question ID : 3961361128
Status : Answered
Chosen Option : D

Comprehension:

In the following passage some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

The James Webb Telescope has beamed back the (1) pictures of Neptune, the
last planet in our Solar System, in (2) 30 years. The telescope has revealed the
icy giant in a new light, (3) 4.3 billion kilometres away from Earth, at the

(4) of the Solar System.

The telescope has picked up a crisp view of the rings of Neptune, (5) had last
been seen only in pictures taken by the Voyager 2 spacecraft when it conducted a flyby way
back in 1989. Since then, the Voyager spacecraft is flying in interstellar space, millions of
kilometres away from Neptune where the Sun’s impact ends.

SubQuestion No : 47
Q.47 Select the most appropriate option to fill in the blank no. 2.
Ans X A. quite

25 B. rather

5 C.on
«” D. over

Question ID : 3961361129
Status : Answered
Chosen Option : C
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Comprehension:

In the following passage some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

The James Webb Telescope has beamed back the (1) pictures of Neptune, the
last planet in our Solar System, in (2) 30 years. The telescope has revealed the
icy giant in a new light, (3) 4.3 billion kilometres away from Earth, at the

(4) of the Solar System.

The telescope has picked up a crisp view of the rings of Neptune, (5) had last
been seen only in pictures taken by the Voyager 2 spacecraft when it conducted a flyby way
back in 1989. Since then, the Voyager spacecraft is flying in interstellar space, millions of
kilometres away from Neptune where the Sun’s impact ends.

SubQuestion No : 48
Q.48 Select the most appropriate option to fill in the blank no. 3.
Ans X A. hang

«” B. hanging
25 C.to hang
25 D. hanged

Question ID : 3961361130
Status : Answered
Chosen Option : B

Comprehension:

In the following passage some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

The James Webb Telescope has beamed back the (1) pictures of Neptune, the
last planet in our Solar System, in (2) 30 years. The telescope has revealed the
icy giant in a new light, (3) 4.3 billion kilometres away from Earth, at the

(4) of the Solar System.

The telescope has picked up a crisp view of the rings of Neptune, (5) had last
been seen only in pictures taken by the Voyager 2 spacecraft when it conducted a flyby way
back in 1989. Since then, the Voyager spacecraft is flying in interstellar space, millions of
kilometres away from Neptune where the Sun’s impact ends.

SubQuestion No : 49
Q.49 Select the most appropriate option to fill in the blank no. 4.
Ans X A. back

25 B. bank
25 C. side

«” D. edge

Question ID : 3961361131
Status : Answered
Chosen Option : A
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Q.50
Ans

Comprehension:

In the following passage some words have been deleted. Read the passage carefully and
select the most appropriate option to fill in each blank.

The James Webb Telescope has beamed back the (1) pictures of Neptune, the
last planet in our Solar System, in (2) 30 years. The telescope has revealed the
icy giant in a new light, (3) 4.3 billion kilometres away from Earth, at the

(4) of the Solar System.

The telescope has picked up a crisp view of the rings of Neptune, (5) had last
been seen only in pictures taken by the Voyager 2 spacecraft when it conducted a flyby way
back in 1989. Since then, the Voyager spacecraft is flying in interstellar space, millions of
kilometres away from Neptune where the Sun’s impact ends.

SubQuestion No : 50
Select the most appropriate option to fill in the blank no. 5.
75 A. whom

«” B. which
75 C. what
75 D.who

Question ID : 3961361132

Chosen Option : A

Status : Answered

Q.51
Ans

Comprehension:
Read the following passage and answer the questions that follow.

The arrival of eight cheetahs in Gwalior, India on 17 September was a huge moment for a
country where the animal was declared extinct back in 1952 due to loss of habitat and
hunting. The cheetahs travelled from Namibia in a specially painted aircraft with a tiger’s face
on it and the special Boeing 747 jet quickly became a sensation on social media. However,
contrary to popular sentiment and some media reports, it was not painted for the occasion.
According to Newschecker, the plane was actually painted back in 2015 by Russian airline
Transaero. The image on the plane was that of a Siberian Tiger and the purpose behind the
painting was to increase awareness about the animals. The report further stated that the
painting was a collaboration between the airlines and Amur Tiger Centre—an initiative signed
by Russian President Vladimir Putin.

The first appearance of the flight with the tiger painting on its nose came in June 2015 at the
Moscow Vnukovo airport. However, as Transaero went bankrupt, the plane was sent to
storage in Spain before it was purchased by Sharjah-based Aquiline International in 2021 and
leased it to Terra Avia of Moldova.

As a result, it was either pure coincidence or a planned strategy to use the specific flight for
the transfer of cheetahs to India but the fact that it was specially painted for the occasion was
not true.

The other possible explanation, according to Newschecker, was that the cheetahs needed to
be transported in a jumbo-sized passenger plane and this was one of the few available for
that purpose

The aircraft was arranged by Dubai-based Action Aviation for the project.

SubQuestion No : 51
What kind of a passage is it?

< A. A government explanation
«” B. Anews item

25 C. An investigative report
25 D. Areview article

Question ID : 3961361134

Chosen Option : C

Status : Answered
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Ans

Comprehension:
Read the following passage and answer the questions that follow.

The arrival of eight cheetahs in Gwalior, India on 17 September was a huge moment for a
country where the animal was declared extinct back in 1952 due to loss of habitat and
hunting. The cheetahs travelled from Namibia in a specially painted aircraft with a tiger’s face
on it and the special Boeing 747 jet quickly became a sensation on social media. However,
contrary to popular sentiment and some media reports, it was not painted for the occasion.
According to Newschecker, the plane was actually painted back in 2015 by Russian airline
Transaero. The image on the plane was that of a Siberian Tiger and the purpose behind the
painting was to increase awareness about the animals. The report further stated that the
painting was a collaboration between the airlines and Amur Tiger Centre—an initiative signed
by Russian President Vladimir Putin.

The first appearance of the flight with the tiger painting on its nose came in June 2015 at the
Moscow Vnukovo airport. However, as Transaero went bankrupt, the plane was sent to
storage in Spain before it was purchased by Sharjah-based Aquiline International in 2021 and
leased it to Terra Avia of Moldova.

As a result, it was either pure coincidence or a planned strategy to use the specific flight for
the transfer of cheetahs to India but the fact that it was specially painted for the occasion was
not true.

The other possible explanation, according to Newschecker, was that the cheetahs needed to
be transported in a jumbo-sized passenger plane and this was one of the few available for
that purpose

The aircraft was arranged by Dubai-based Action Aviation for the project.

SubQuestion No : 52

Q.52 What is the main theme of the passage?

& A. The tiger-faced airplane
25 B. The bankrupt airlines
5 C. The arrival of eight cheetahs

25 D. The transportation of cheetahs

Question ID : 3961361135
Status : Answered
Chosen Option : D
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Comprehension:
Read the following passage and answer the questions that follow.

The arrival of eight cheetahs in Gwalior, India on 17 September was a huge moment for a
country where the animal was declared extinct back in 1952 due to loss of habitat and
hunting. The cheetahs travelled from Namibia in a specially painted aircraft with a tiger’s face
on it and the special Boeing 747 jet quickly became a sensation on social media. However,
contrary to popular sentiment and some media reports, it was not painted for the occasion.
According to Newschecker, the plane was actually painted back in 2015 by Russian airline
Transaero. The image on the plane was that of a Siberian Tiger and the purpose behind the
painting was to increase awareness about the animals. The report further stated that the
painting was a collaboration between the airlines and Amur Tiger Centre—an initiative signed
by Russian President Vladimir Putin.

The first appearance of the flight with the tiger painting on its nose came in June 2015 at the
Moscow Vnukovo airport. However, as Transaero went bankrupt, the plane was sent to
storage in Spain before it was purchased by Sharjah-based Aquiline International in 2021 and
leased it to Terra Avia of Moldova.

As a result, it was either pure coincidence or a planned strategy to use the specific flight for
the transfer of cheetahs to India but the fact that it was specially painted for the occasion was
not true.

The other possible explanation, according to Newschecker, was that the cheetahs needed to
be transported in a jumbo-sized passenger plane and this was one of the few available for
that purpose

The aircraft was arranged by Dubai-based Action Aviation for the project.

SubQuestion No : 53
Q.53 What was the purpose of painting a tiger’s face on a plane?

Ans X A.lt was painted on the orders from the Russian President.
< B. It was specially painted as the plane was going to transport cheetahs.
/< C. It was painted to indicate that the plane was an animal carrier.

«” D. It was painted to increase awareness about animals.

Question ID : 3961361136
Status : Answered
Chosen Option : B
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Comprehension:
Read the following passage and answer the questions that follow.

The arrival of eight cheetahs in Gwalior, India on 17 September was a huge moment for a
country where the animal was declared extinct back in 1952 due to loss of habitat and
hunting. The cheetahs travelled from Namibia in a specially painted aircraft with a tiger’s face
on it and the special Boeing 747 jet quickly became a sensation on social media. However,
contrary to popular sentiment and some media reports, it was not painted for the occasion.
According to Newschecker, the plane was actually painted back in 2015 by Russian airline
Transaero. The image on the plane was that of a Siberian Tiger and the purpose behind the
painting was to increase awareness about the animals. The report further stated that the
painting was a collaboration between the airlines and Amur Tiger Centre—an initiative signed
by Russian President Vladimir Putin.

The first appearance of the flight with the tiger painting on its nose came in June 2015 at the
Moscow Vnukovo airport. However, as Transaero went bankrupt, the plane was sent to
storage in Spain before it was purchased by Sharjah-based Aquiline International in 2021 and
leased it to Terra Avia of Moldova.

As a result, it was either pure coincidence or a planned strategy to use the specific flight for
the transfer of cheetahs to India but the fact that it was specially painted for the occasion was
not true.

The other possible explanation, according to Newschecker, was that the cheetahs needed to
be transported in a jumbo-sized passenger plane and this was one of the few available for
that purpose

The aircraft was arranged by Dubai-based Action Aviation for the project.

SubQuestion No : 54

Q.54 What did the people and media in India think about the tiger-faced plane that
transported the cheetahs from Namibia to India?

Ans X A. It was the only suitable plane available for the purpose.
< B. It was a coincidence that the government got that plane for the purpose.

25 C. It was a planned strategy of the government to acquire that special plane for the
purpose.

" D. The government has purposely got the plane painted for the occasion.

Question ID : 3961361137

Chosen Option : D

Status : Answered
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Comprehension:
Read the following passage and answer the questions that follow.

The arrival of eight cheetahs in Gwalior, India on 17 September was a huge moment for a
country where the animal was declared extinct back in 1952 due to loss of habitat and
hunting. The cheetahs travelled from Namibia in a specially painted aircraft with a tiger’s face
on it and the special Boeing 747 jet quickly became a sensation on social media. However,
contrary to popular sentiment and some media reports, it was not painted for the occasion.
According to Newschecker, the plane was actually painted back in 2015 by Russian airline
Transaero. The image on the plane was that of a Siberian Tiger and the purpose behind the
painting was to increase awareness about the animals. The report further stated that the
painting was a collaboration between the airlines and Amur Tiger Centre—an initiative signed
by Russian President Vladimir Putin.

The first appearance of the flight with the tiger painting on its nose came in June 2015 at the
Moscow Vnukovo airport. However, as Transaero went bankrupt, the plane was sent to
storage in Spain before it was purchased by Sharjah-based Aquiline International in 2021 and
leased it to Terra Avia of Moldova.

As a result, it was either pure coincidence or a planned strategy to use the specific flight for
the transfer of cheetahs to India but the fact that it was specially painted for the occasion was
not true.

The other possible explanation, according to Newschecker, was that the cheetahs needed to
be transported in a jumbo-sized passenger plane and this was one of the few available for
that purpose

The aircraft was arranged by Dubai-based Action Aviation for the project.

SubQuestion No : 55
Q.55 Which statement is NOT true about the tiger-faced plane?

Ans X A. The image on the plane was that of a Siberian Tiger and not of Indian tiger.
«” B. The plane was sent to the Indian government by the Transaero airlines.
5 C. The painting was a collaboration between the airlines and Amur Tiger Centre.

< D. The plane was actually painted back in 2015 by Russian airline Transaero.

Question ID : 3961361138
Status : Answered
Chosen Option : A
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